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Introduction

Throughout this manual this version of the “ NMFS Electronic Reporting System” will be
referred to smply asthe “ER System V2'. This distribution of ER System V2 is for
vessel processorsonly. A separate distribution of the ER System is available for shoreside
processors.

The ER System was developed by NMFS to allow processing vessels to submit Federal
reportsto NMFS by electronic means, as opposed to filling in blank forms and faxing them
to Juneau. While processing vessels are at sea, they can submit reports viae-mail or direct
from a modem from their computer on board. The ER System s intended to help
processing vessels by making the reporting process smpler and more accurate. The ER
System also helps NMFS because the catch data from the processing vesselsis
automatically entered into the NMFS database. This automatic data entry eliminates
possible data entry errors when NMFS staff enters catch datainto NMFS databases.

Currently there is one type of report used with the processor vessel ER System V2:

Weekly Production Reports (WPRS)

WPRs contain weekly reporting on the species and amount of fish harvested and
how the fish was processed. Data collected include target species, gear type,
production type, discard species, weights, and reporting area.

System Requirements

The ER System V2 requires a computer running Windows 95, 98, NT, or compatible
operating system.

Electronic transmission of data files requires a modem or compatible device or a
messaging system such as internet email or Inmarsat C.

Technical Support

If you encounter any problems installing the software or in using the system please call
(907) 586-7085 and ask for electronic reporting technical support, or you can e-mail
er.help@noaa.gov

How to obtain ER software

NMFS will mail you an ER System V2 installation CD upon request. Call the NMFS
Juneau office at (907)586-7228, the NMFS Dutch Harbor office at (907)581-2062, or the
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NMFS Kodiak office at (907) 481-1781 to make arrangements to get an installation CD.
Y ou can also download the ER system software from the NMFS homepage at
www.fakr.noaa.gov.

Installing the ER System V2 from CD

This software requires Windows95, 98 or WindowsNT, and is provided in Compact Disc
(CD) format.

1) Close al other applications.

2) Make sure that you do not install a duplicate copy of ER System V2 on your machine.

If a previous installation has been done, it MUST be removed before you install again.
Please refer to the section on Uninstalling ER System Software.

However, ER System V2 may be installed on a computer with the previous version of
ER software (Version 1.5). Y ou may wish to regain version 1.5 if you want to access
1998 or 1999 data that were entered with that version.

3) Run the Setup.exe program from the ER Version 2 CD. One way to locate and run

4)

this programiis:

a) Click onthe START button in the lower left corner of the screen, and highlight the
PROGRAMS menu.

b) Choose “ Windows NT Explorer” or “ Windows Explorer” from the menu.

¢) From the “Explorer” screen, click on “ My Computer” in the top left side of the
screen.

d) In the contents of “ My Computer”, check to see which disk drive is labelled CD-
ROM.

€) Place the NMFS Electronic Reporting System Vessel WPR CD-ROM in the CD
drive of your computer, and close the CD drive door.

f) Click on the CD-ROM’s disk drive in the left hand side of your screen. Thiswill
cause al the files on the CD-ROM to be listed on your screen.

g) Scroll down the list of files an double-click on a file named “setup.exe’. Thiswill
start the installation procedure.

The first screen you see should be areminder to exit all other software before
attempting installation of ER. Click OK.
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5) You are prompted for your Alaska Federal Fisheries Permit Number. Enter the 4 digit
number that identifies your processor. This number isfound on your Federal fisheries or
processor permit.

6) The next screen will request that your specify a destination directory for installing this
software. It isrecommended that you accept the default directory of C:\Program Files\ER
Client2\. Click the big button to accept this default directory.

7) The next screen should say that the program has installed sucessfully,

8) To start up the ER System, push the START button in the lower left corner, click on
PROGRAMS, and from the menu list under PROGRAMS, click on ER Client 2.

Installing the ER System from the Internet

The NMFS Electronic Reporting client software can be downloaded from the Electronic
Reporting Homepage * http://www.fakr.noaa.gov/nmfs_er/’.

Steps to download the ER system:

1 Create atemporary folder (directory) named C:\ERTemp. Fileswill be
downloaded to this folder.

2. Go to the Electronic Reporting screen at the NMFS Homepage:
http://www.fakr.noaa.gov/nmfs_er/

3. Thereis ablue hypertext areato click: ERV2Vess.EXE
Thiswill download the NMFS Electronic Reporting client software Version 2 for
processor vessels.

Shoreside processors should download the file ERV 2Elog.EXE
These are compressed, self-extracting files.

4, In MS Internet Explorer, the 'Save As screen will appear. Make certain that the
ERTemp folder is selected. You will have to select ERTemp yourself. Then press
Save.

6. After the software is downloaded, you need to decompress the files. Run the self-
extracting file by double-clicking on its name. The files will extract to the same
directory (ERTemp).

7. After the files are decompressed, you need to run the file * Setup.exe’, which is part
of the ER software. To run thefile ‘ Setup.exe’, click the Start button on the task
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bar, then pressRun. Typein: C:\ERTemp\setup.exe then press OK. Follow
steps 4-8 of the CD installation listed above.

Uninstalling ER System Software

It may be necessary to uninstall and re-install the ER System software. Before
uninstalling, make sure that you have a current backup of your ER database. Check with
NMFS to make sure that the data associated with your current ER System software will
not be lost if you have any question about the correct procedures.

To uninstall the ER System Software, click on the START button in the lower left corner
of your screen, then click on SETTINGS, CONTROL PANEL, and finally on
ADD/REMOVE programs. Follow the prompts to remove the entire ER System
software. After removing the ER System software, it isa good ideato look in the
directory where it was previoudly installed and check to make sure that al of the filesin
that folder have been removed. Now it is safe to re-install the ER System software in the
same folder.

Starting the system

To start the ER System software click the Start button at the bottom left corner of the
screen, then highlight Programs. Click on the ‘ER Client 2" item in the Programs list and
the software will start.

The first time you start the ER software the Login screen appears with “ Admin” in the
User field. Initiadly, there is no password for “ Admin” , smply pressthe ENTER key to
continue. If you choose not to implement password protection the Login screen will
always open this way.

Login |

User: |admin

Paszword: |

THE MAIN SCREEN
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After you log in, the system opens the NMFS ELECTRONIC REPORTING CLIENT
SCREEN, hereafter called MAIN SCREEN. The MAIN SCREEN has 4 tabs: “ About”,
“ Database’, “Transmit”, and “Communication Settings’. After you log in, the screen
defaultsto the * About” tab. The 4 tabs are described below:

& Electronic Heporting Client (S]] |

NMFS Electronic Reporting Client

Version: 211 BC -Yeszel Client Yeszzel Weekly Production Bepart

Current Report Type
Contact [nformation

oD BMOSES.
G

9

=
n'f Zl'l
!:2‘! %l'i
I bt
= |
i % *E'G,'J
¢ ol
5 @e q;f_}f
s, -

* bout || Database | Transmit | Cammunications Settings

Open Repaort I

Exit

‘About’ Tab:

Under the Current Report Type in the right-hand side of the screen, highlight “Contact
Information” and click on “open Report”. This screen contains basic information
regarding your vessel. The Name, Federal Permit #, and ADF& G Permit # should already
have the correct values for your processing vessel typed in. The other blank fields are
Phone, FAX, E-mail and Representative. Please fill them in with your most current
information. It isimportant to enter thisinformation and keep it up-to-date because the
information shown on this screen is automatically entered in the header section of reports
generated by this software.

‘Database’ Tab:

When you click on the DATABASE tab, you see the DATABASE screen. This screen
has several functions associated with the ER System databases.
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& Electronic Heporting Client

Custern Databaze: Current Report Type
: : - Contact [nformation
IE.'\F‘ngram Filez"\ERClhent2"ER S ys. mdws _I escalthieakln Prodhelion Eeperk
Client Databaze:
|E:'\F‘rn:ngram Files\ERCliert2AERD ata.mdb |
Curent Uzer: 2dimin Logot az Mew User
Backup Compact Edit Uzers/Pazzwardz
R estore Migrate
Abaut i Databaze i| Transmit | Communications Settings Open Repart I
Exit

System Database and Client Database

Clicking on the “ Database Button” shows the Database screen. The top two boxes on the
left allow you to specify where the electronic copies of the two Microsoft Access
databases are stored. These two databases are used together by the ER System software
to store the information that you keypunch in the computer for your Weekly Processor
Reports (WPRs). Usually both the System Database and the Client Database are stored in
the same folder (directory).

Password function

User names and passwords are optional in the ER software. If you decide not to assign
user names and passwords, then all users can login as user name “ Admin” and do not usea
password. However, if you decide to use the user name/password function, the system
administrator (whoever is responsible for maintaining the ER System) should be in charge
of it. The system administrator would take the user name “ Admin” and create a password
for the system administrator’s use. The System Administrator would assign user names
and passwords to each person using the ER System software.

To use the user name/password function, make sure you are in the DATABASE screen
and click on the button “Edit Users/Passwords’. Y ou will see the following screen:
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i Edit Uzer/Pazswords I

— Uszer — Change Pazswaord
I adriin _ﬂ

e | i'.ir-,!—;-'r.el

Mew Password: l

Werify: l

— [araup Memberzhip-
W Adrin
[ Change |

There are two levels of permissions, Admin and User. People with Admin rights have
access to everything in the system. They can change the information in the Client Settings
screen or make changes to the communications settings. They can also add to or change
password combinations.

People in the User category can only work on the NMFS reports (create, edit, revise,

print, and transmit). They do not have access to the Client Information screen and can't
change the communications settings of the system. In addition they are not allowed access
to the password function.

There are two basic ways to use the password function:

1) Partia password system: assign user names only. Any type of name can be assigned,;
first name only, first and last name, or a persons’ initials can be used. No password is
needed: when the login screen appears type in the user name and hit the ENTER key.

2) Combination user name and password system: assign user names in combination with
unique passwords. The user must type in avalid user name as well as the password
associated with that name.

*note that passwords are case-sensitive (i.e. if the password is entered as“Tom” then
subsequent logins must be typed in exactly the same way, “tom” will not work).

To add a new user to the list click on the “ New” button, and a New User screen will
display. The new user screen looks like this;

Newlser ]

T =

k. I Cancel |
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After the New User has been entered, use the mouse pointer to choose the Group
Membership by clicking on the check-box next to Admin or User. New users must belong
to at least one of the two groups, or can belong to both.

If you want to create a unique password for the new user, click on the New Password
field. Typein apassword, any combination of characters and numbers can be used. Type
in the same password in the Verify field. Click the mouse pointer on the Change button
and a message appears stating the password has been changed successfully.

Anyone with Admin rights can add new users, view the list of current users, and delete
usersfromthelist. To delete auser from the list, use the mouse pointer to highlight the
name and click on the Delete button.

‘BACKUP’, ‘RESTORE’, ‘COMPACT’ and ‘MIGRATE’ Buttons:

BACKUP button. The BACKUP button allows you to save a copy of your current datain
Microsoft Access format to alocation that you specify. Ideally, you would backup your
datato afloppy disk, ZIP drive, or other format that is removable from your computer.
That way, if your computer is damaged, you still have your data safely saved. Daily
backup of your data is recommended.

RESTORE button. The Restore button allows you to get a previously backed-up copy of
your data and overwrite it to your current ER System software. For example, if you kept
your ER System software on the hard disk in your computer, and your data was backed-
up on afloppy disk drive, and the hard dish failed - you would lose your ER System
software. You could then purchase and install a new hard disk drive and re-install the ER
System software, and use the restore button to get the backed up copy of your data from
your floppy disk.

COMPACT button. The COMPACT button uses a Microsoft Access database function
that compacts the data so less space is used in electronic storage.

MIGRATE button. Thiswill be used to move data from a previous ER V2 instalation
into a new database if the software is upgraded.

‘TRANSMIT’ Tab:
Clicking on the TRANSMIT tab on the MAIN PAGE allows you to select the
transmission method: internet e-mail, modem-to-modem, or export to file and send via e-

mail.
The TRANSMIT screen looks like this:
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& Electronic Heporting Client

Current Report Type

Contact [nformation
Yeszzel Weekly Production Bepart

i~ Tranzrmizzion Method

% |nternet Transmit uging the Internet.

" Moderm-to-madern Direct modem connection ta MMES.

" Export ko file Create file to attach to an e-mail.
Transmit Reports Processz Return Receipts
Yiew Tranzsmizsion Bepart Send Test Meszage

About | Databaze | Tranemit | Communications Settings

Open Repaort I

Exit

The 4 buttons at the bottom of the TRANSMIT screen are Transmit Reports, View
Transmission Report, Process Return Receipts, and Send test Message.

Transmit Reports. Clicking the Transmit Reports button will transmit any new report or
any report that has been modified. Y ou cannot choose which reportsto transmit. All
available reports will be transmitted automatically.

View Transmission Report. Clicking the View Transmission Report button will show a
list of reports that have been transmitted along with the transmission history. You can
choose one of the reports and view its associated information.

Process Return Receipts. Clicking the Process Return Receipts button will locate any
recently received transmission reports that have arrived from NMFS and the ER System
will update the Transmission Report to show which reports that have been transmitted to
NMFS have been received.

Send Test Message. Clicking the Send Test Message button will test whether the internet,
modem or e-mail transmission method is working. Y ou will receive areturn receipt from
NMFS if the 2-way connection is working.

‘COMMUNICATIONS SETTINGS’ Tab
Clicking the COMMUNICATIONS SETTINGS tab in the MAIN MENU shows the

screen below. This screen allows the user to specify the computer’s settings so that the
chosen transmission method will work. These communication settings and basic
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communications functions are normally established automatically during the first-time
installation of the software.

There are 3 ways to transmit the WPR information to NMFS: through internet e-mail,
direct modem connection to NMFS, and create afile and attach it to an e-mail using your
own e-mail software.

& Electronic Heporting Client (S]] |

Current Report Type
Contact [nformation

— |nternet Settings
SKMTF Mail Haost: l

Return E-mail Address: l

Yeszzel Weekly Production Bepart

= Modem-to-todem Settingz
Fart Settings I FPhone Mumbers

todem Settings I Sdvanced

Feturn Receipt Directon:
IE:"\F'rngram FilezhE R Client2,
Output Directary:
|C:\Program Files\E R Client2!

B

Aot I Database | Tranzmit § Communications Settings_@i BRer Bene I

Exit

I nternet Settings

To transmit the WPR information to NMFS by internet e-mail, you need to type in the
SMTP Mail Host name in the blank space provided. The SMTP Mail Host name is the
name of the computer that providesthe internet e-mail service. Next, enter the Return E-
Mail Address. Thisisyour e-mail address at your internet e-mail service provider. A
common internet e-mail service provider is America On Line (AOL).

Modem to Modem Settings

Under this heading there are 4 buttons. Port Settings, Modem Settings, Phone Numbers,
and Advanced buttons. All 4 of these buttons are necessary to configure your modem so
that it works correctly. Some of the information you need to fill in this information can be
obtained from the modem'’ s documentation. Y ou can also use the Windows Control Panel
to view the current hardware installed on your system, which includes the some modem
information.
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Step 1. Choose the Port Settings button. On the Port Settings screen, set the port number
and baud settings. Accept defaults on al others. (Windows Control Panel has port
number and baud settings information)

= Port Settings |

— Part Settingz

Select the port and
Lo Pork: w o baud rate walues for

R~ Eﬂﬂ_ﬂ o moden,
Datatits [ ] || the NMFS Homt, date
B m ttrl:nas,_fr:lar-lsiettlngs zhauld
Stop bitg: I1 "'I ‘Hardware[RT5/CTST

and 'Set OTH line high'

hauld both b
= Flow Control——————— zhz;ked? E
¥ Hardware (RTS/CTS)
[T Software FHONA0FF)
v SetDIR line high
W SetBTS line gt Ok Cancel

Step 2. Choose the M odem Settings button. Choose the modem make and model. If
you don't find your model, select one that is similar to yours, or try 'Hayes compatible’. If
modem setup is successful, you will see a"Modem initialized" screen.

= Modem Settings I
Utilitiez

b odel:

D ataStart for Compar

Best Data
Bocamodem
Cardinal
Codex _I_I
Caomm Fart: i 2 QK Cancel
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Step 3. Choose the Phone List button. Thisis where vessal-specific prefix's and suffix's
to the basic phone number are entered. Every vessel and shoreside processor will need to
inspect this screen on first time modem setup and make sure that the entire modem dial
string is correct for their location, such as area code, number to get out of local PBX, and
satellite hardware strings.

&# Phone Mumbers I

Tranzmit Destination

&dd

Rermowve I
— Modem Strng

Prefix: IE!
Phone Mumbet: ![ ] 58E-7279

Suffix: !
95867279
k. Cancel |

Step 4. Choose the Advanced button. Thisis where the communications settings for the
modem are set.

Z Communication: Settings

InBuffer Size: rEI-:I_a@' Inittd odem Tirneout: I-_E
OutBuffer Size: i_znﬁ Carrier Detect Time: r—ﬂ
InT imeoLt; I_EI Losgt Carrier Delay; [_D
Dial Timeout; ﬁ Hangup Pause: I-_Eld

¥ Modify Init String
[V LogEvents Ok, | Cancel |

Warning! Settings on this Communications Settings screen should not be modified
without the guidance of NMFS technical support. This screen is for customizing
transmission settings in case the modem can't be setup successfully using the other modem
to modem settings buttons.
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Vessel Processor WPRs

To create anew WPR:

Choose 'V essel Weekly Production Report’ from the heading ‘ Current Report Type” in
the Main Menu.

Press the * Open Report’ button at the bottom of the page.

Pressthe ‘New WPR’ button at the bottom of the page.

Weekly Production Reports are summaries of a processing vessel’s activities for a given
week. With the exception of January 1 and December 31, weekly reporting periods start
at 0001 hours Sunday morning and end at 2400 hours (midnight) on Saturday. When
choosing a date for the WPR you need to choose a valid week ending date (i.e. a
Saturday).

Vessel Processor WPR
Report view

WPR'’s are made up of two separate elements; a master report (called the Report View)
and worksheets (Worksheet View). Worksheets contain the bulk of the WPR data and
include the Week Ending Date, Gear Type, and Product and Discard information. A
completed WPR will contain one report view as well as one or more worksheets. A new
WPR opens up in the Report view.

Some vessels operate as both 'catcher processor' and as 'mothership'. If you change the
Vessal Type in the Client Settings screen, all subsequent reports will default to the
changed type. Verify that the Vessel Typeis correct for the current week’s operations and
enter the number of crew.

Fish Tickets

ADF& G Fish Tickets are voluntary for catcher/processors and are required of
motherships. The format for fish tickets is a series number and year, followed by a six
digit number. An example of a series G groundfish ticket is: G97000441. Note that if you
try to enter this as number 441 in the ER software the number will be rejected.

Thisiswhat the Report View looks like:
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§f NMF5 Electronic Reporting - Yeszel WPR
Eile Edit ‘worksheets Beports

D|-’;1|H|><.| &|§|

—week End Date- — Operating Mode Mo in Crew -
£ Mathership
I L/ E :I | 0 Z—]
i |7'f: Catcher/Froceszor
Fizh Tickets
*] |

Products Cloze |

The Report View screen contains the Fish Ticket data. 1f you need to enter a series of
consecutive fish tickets you can save time by entering in arange of fish ticket numbers.
To enter arange of numbers:

Choose Fish Ticket Range from the Edit menu

In the “From” box enter the beginning fish ticket number
Inthe“To” box enter the last fish ticket number

Hit the OK button

Notice the Products button to the left of the Close button in the Report View screen. Itis
dimmed because no worksheets have been created for thisreport. If there are worksheets,
the Products button would be bold and could be used to toggle to the worksheets. If no
worksheets have been created, you need to click the mouse pointer on the “ New
Worksheet” icon on the toolbar, or choose “ New Worksheet” from the File menu on the
menu bar.

Data entry starts in the Week End Date field and moves from left-to-right, top-to-bottom.

Any field with an arrow next to it contains a drop-down list that can be used to fill in the
field’s value.
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Worksheet View

Weekly production reports are designed to allow one report to have data from multiple
areas (or gear types). A single WPR can contain multiple worksheets for weeks when you
fishin different areas or change gear type (or go from open access fishing to CDQ
operations). When more than one worksheet is present, the box at the bottom of the
screen will indicate which worksheet is visible. One worksheet overlays the other, so that
only one worksheet isvisible at atime. To create additional worksheets click the mouse
pointer on the “ New Worksheet” icon on the toolbar, or choose “ New Worksheet” from
the File menu on the menu bar.

&# MMFS Electronic Reporting - Yessel WPR M= B2
Eile Edit ‘worksheets Beports
D|-’J|H| ><.| &|§|
TEﬂ“EEEl U nits af sure: [ 13 p.:!|_4r||j:§:- o r!'!Ee.tri]:: tn;lr.'!j;-
: T, By 1 -Foonn
~Worksheet A
Repaorting Area: || - I Special Area: I - I tanagement Frograrm: I - I
Gear Type: I vI Account/Permit #: I
Frimany T arget: I j Secondary Target: j
Products T Dizcards/Donated ]
Species FPa&AR | Product Wieight [rot] [ =
*
I HI 4 IWDrksheet 1af1 B I HI Fizh Tickets Cloze |

Enter the Federal reporting area, and Gear type. Enter the appropriate Special Area code
if you are fishing in the COBLZ (C. opilio crab bycatch limitation zone) or the Red King
Crab Savings Area (RKCSA). Consult your logbook reference manual for the special area
coordinates.

If you are fishing in the CDQ fishery or under an experimental or research permit, select
the appropriate code under Management Program. Use the down arrow and select the
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program or type in the first letter of the appropriate program and the system will fill in the
rest. If you are not fishing in one of the listed M anagement Programsthen leave this
box and the Account/Permit # box blank. If you are fishing in alisted program enter
the * Account/Permit’ number ( e.g. IFQ permit number, CDQ group number (51...56),
AFA inshore Coop number (101...108)).

Enter the species code of your primary and secondary groundfish target species for the
CURRENT week only.

Product Tab

The worksheet data entry section is divided into two Tabs (these are like folders): Product
and Discard. The Product tab is the default tab. When activated “Products’ will be a
bold font and aline appears below the Product Tab that’s formatted for product data
After the first line of data has been entered you create the next line by hitting the TAB key
or clicking on the asterisk below the first line.

Discard Tab
To change to Discard data entry, click on the Discard Tab. Notice that “Discard” isin
bold and “Products’ isin regular text.

To move from the Worksheet View to the Report View, click on the Fish Ticket button at
the bottom of the screen.

Transmitting Reports

A report’s status may be one of ‘Open', ‘Queued', ‘ Sent’, or *Recelved'. An open, or
current report is one that has been created in the client application but has never been
transmitted to the NMFS. You can freely edit or delete an open report until the report is
transmitted.

Transmission Queue

In order to transmit areport, you must put the report in the transmission queue. There are
two ways to put the report in the transmission queue. First, by checking the "Transmit'
check box in the report screen, as seen below:
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i Report List

Repots | Fite |
“Week End Date] tode ] L azt M odified ] Sent Date ] Transmit?]
| B | 1/22/00 P 1/4200 9:41:50 &M ' [ ™
Mew'WPR | Betanzmi Delete Edit Cancel

A second way to queue areport isin the 'View Transmisson Report’ button on the
Transmit tab of the Main Screen, by checking the Transmit box as you can see below.

i Review reports to transmit ...

: | Filter ]
“Week End Date] tode ] L azt M odified ] Sent Date ] Deleted 1 Transmit?]
| B | 1/22/00 P 1/4200 9:41:50 &M ' | | |
He-transmiq Delete | Tranzmit| Cancel
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Both actions have the effect of setting the report’s status to ‘Queued’. A queued report
may continue to be edited just like an open report up until the time that the next
transmission actually takes place. A report may also be easily removed from the
transmission queue by unchecking the Transmit box: in effect changing its status back to
‘Open'.

When a transmission actually takes place, all the reports whose statusis ‘ Queued’ are
exported to the transmission data file, and the file is transmitted to the NMFS host. |If the
transmission is successful, all queued reports then have their status changed to ‘ Sent’.
Once sent, areport can no longer be edited in the client application. In order to change
the data on a sent report, the user must create arevision of the report and transmit the
revisonto NMFS. When arevision is created, a new, open report is created, (with the
report number and all the data from the old report). The steps for editing, queuing, and
sending the revision are the same as for any other new report.

Return Receipts

After reports have been transmitted and received successfully by the by the NMFS host
system, areturn receipt will be generated and sent to the vessel processor to acknowledge
receipt of the report. These return receipts are stored until you use the ‘ Process Return
Receipts button in the Transmit tab of the MAIN PAGE. At that time, your ER System
will mark the appropriate reports as ‘received’, and they will no longer be sent when the
‘Transmit’ button is pressed.

It isimportant to process return receipts upon receiving them from NMFS by using the
‘Process Return Receipts' button to keep your databases up to date. |f you do not keep
your databases up to date with the most current return receipts from NMFES, you will be
creating unnecessarily large transmission files. This happens because each time reports
are transmitted, the transmission file will automatically include all reports with the status
of ‘Queued’ and ‘Sent’. If their statusis changed to 'Received' they will not be included
in the transmission file.

Exiting the software
To exit the ER software and return to Windows either:

1) Returnto the MAIN PAGE, and press the EXIT button in the bottom center of the
screen. You will immediately exit the program and return to Windows.

2) Inthe Report View screen, click on the ‘File' menu in the upper left corner of the
screen and choose Exit from the menu. Y ou will be prompted by a question as to
whether you want to exit. Choose‘Yes and you will exit the program.
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